This section describes the common workflow of a motion capture session. Whether you are performing routine motion capture or using advanced techniques you will need to perform the tasks outlined in The Motion Capture Session. More complex motion capture techniques are described in Advanced Capture Techniques. This section assumes that you have performed all of the tasks described in Preparation.

The following chapters describe the individual steps in detail. Finally Clean Up describes methods of solving problems with your data.

THE MOTION CAPTURE SESSION
Workflow 04
Motion Capture 04

CHECKING THE QUALITY OF THE VIDEO DATA 15

RECONSTRUCTING 3D DATA
Reconstruction Parameters 16
The quality of the reconstruction 17
Optimising Reconstruction Parameters 18

VIEWING DATA
Using the Time Bar to control playback 21
General viewing options: the View menu 24
Other Windows 25

LABELLING THE DATA
How to assign a label 27

AUTOLABELLING
Autolabel calibration 29
Checking the Autolabel results 31
Reasons for poor autolabelling 31
Autolabel parameters 32

TRIAL TYPES
Default trial types: General Capture 34
Default Trial Types: More examples 37

THE VICON PIPELINE
Default pipeline: capture and reconstruct data 40
Workflow
This chapter takes you through all the basic steps required for motion capture, once you have prepared the system. The later parts of this section provide more detail about these individual steps.

The workflow described here is:
- Set up the Eclipse hierarchy to organise your motion capture data
- Check the system is working correctly
- Calibrate the system
- Capture a static trial
- View the captured data
- Label subject and create a Subject Calibration
- Capture a dynamic trial
- Reconstruct and label the data
- Clean up and edit data

Before performing motion capture you should have:
- Software installed, hardware connected and the system functioning correctly
- Capture Space set up
- A subject with markers attached
Datastation and Workstation have both been started and Link established

Motion Capture
Before starting you should decide where you wish to store your Vicon data. You then implement this using the Eclipse data management system.

To create a new Eclipse database:
- Start Workstation from the Windows Start | Programs menu
- Select File | New Database
- Click ‘...’ to open the Browse dialog
- Navigate to the location where you wish to create the database and click OK
- Enter a Name and Description for the database
- Select one of the templates, <Name of Template.eni>
Click Create

The Open Database dialog now opens with the new database selected in the displayed list

Click Open

You can now build the database hierarchy. The nomenclature used by Eclipse depends on the template used.

For Science and Engineering users:
- Click New Patient Classification and enter a name
- Click New Patient and enter a name
- Click New Session and enter a name

For Entertainment and Animation users:
- Click New Project and enter a name
- Click New Capture Day and enter a name
- Click New Session and enter a name

If you are using the Generic template:
- Click New Top Level and enter a name
- Click New Subject and enter a name
- Click New Session and Enter a name

To use an existing database choose Open Database from the file menu and select the database from the Open Database dialog. If the database is not listed then click Browse to locate the database.

For more details on using Eclipse see Managing Vicon Data in the Reference section.

Check the system

First check that the system can view the calibration objects and that settings are correct:

- Place the L-Frame in the middle of your capture volume

- Select System | Live Monitors and visually inspect each camera to check that it can only view the four markers of the L-Frame

- If there are additional reflections these need to be eliminated either by removing them, covering them or if necessary adjusting camera sensitivities, strobe intensities or camera apertures (see Preparation)
THE MOTION CAPTURE SESSION

Calibrate the system

- Verify that the L-frame can be fully seen by at least two cameras
- Select View | Diagnostic Mode and adjust camera sensitivities until you have: at least three lines of video per marker, video lines are stable and represent a sphere

Details of using the Live Monitors in diagnostic mode are given on page 15.

To perform the calibration:
- Select System | Calibrate Cameras to open the Calibrate Cameras dialog
- Ensure that all of the cameras are selected, even if it lists more cameras than you know you have connected to the system
- Under Reference Object ensure that the correct Calibration Reference Object file e.g., example.cro, is selected and that the appropriate name of your calibration object is specified.

If you are unsure which calibration objects you have, refer to the diagram in Vicon Hardware.
- In the Calibration panel ensure that Capture is set to “all new data”
- Click Calibrate. The Data Capture – Calibration (Static) dialog opens. When you are ready:
  - Click Start
  - When the Data Capture - Calibration (Dynamic) dialog appears, remove the L-Frame
  - Ensure the wand is in the volume
  - Click Start
  - Perform the wand wave
  - When you have completed the wand wave click Stop

Complete information on calibrating the system is presented in Preparation.

Create Trial Types

The Trial Types feature allows you to set all the parameters for capturing a trial. This means that you can save these settings for future use. In this section you will create two trial types, one for capturing a static trial and one for capturing a general dynamic trial. You may find that these trial types have already been created. In this case you can use the instructions below to verify the settings in the trial types are correct.
Create a Trial Type for a static trial:
• Select Trial | Trial Types
• Click New
• Enter a name for the type of trial e.g., Static Trial
• Click OK to close the dialog
• In the capture pane select Video data only
• In Default Duration select Time (seconds) and enter 3 in the edit boxes
• Under Default Marker Set enter the Marker diameter in millimetres for the markers you are using
• Under Options select Static trial and Include subject names in labels are the only options selected
• Click Pipeline
• Click to highlight Reconstruct
• Click Options
This opens the Reconstruction Parameters dialog.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Vector (X)</td>
<td>-3500</td>
</tr>
<tr>
<td>Minimum Vector (Y)</td>
<td>-3500</td>
</tr>
<tr>
<td>Minimum Vector (Z)</td>
<td>-100</td>
</tr>
<tr>
<td>Maximum Vector (X)</td>
<td>3500</td>
</tr>
<tr>
<td>Maximum Vector (Y)</td>
<td>3500</td>
</tr>
<tr>
<td>Maximum Vector (Z)</td>
<td>3000</td>
</tr>
<tr>
<td>Max Accn (mm/s/s)</td>
<td>50</td>
</tr>
<tr>
<td>Max Noise Factor</td>
<td>7</td>
</tr>
<tr>
<td>Intersection Limit (mm)</td>
<td>12</td>
</tr>
<tr>
<td>Residual Factor</td>
<td>2</td>
</tr>
<tr>
<td>Predictor Radius</td>
<td>30</td>
</tr>
<tr>
<td>Min Cameras to start</td>
<td>0</td>
</tr>
</tbody>
</table>
THE MOTION CAPTURE SESSION

Ensure that the settings in this dialog are as shown in the table above

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>trajectory</td>
<td></td>
</tr>
<tr>
<td>Non-circular markers</td>
<td>Discard</td>
</tr>
</tbody>
</table>

More details of reconstruction and reconstruction parameters are given on page 16

Click OK to close this dialog

Ensure that Reconstruct is the only option selected in the Pipeline dialog

Click OK to close the Pipeline

Click OK to close the Trial Types dialog

Create a Trial Types for a dynamic trial:

Select Trial | Trial Types

Click New

Enter a name for the type of trial e.g., Dynamic Trial

Click OK to close the dialog

In the capture pane select Video data only

In Default Duration select Indefinite ....

Under Default Marker Set enter the Marker diameter in millimetres for the markers you are using

Under Options select Include subject names in labels and Select default or last used subject are the only options selected

Click Pipeline

Click to highlight Reconstruct

Click Options

Ensure that the settings in the Reconstruction Parameters dialog are as shown in the figure above
THE MOTION CAPTURE SESSION

• Click OK to close this dialog
• Click to highlight Label
• Click Options

This opens the Autolabelling Parameters dialog.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Deviation</td>
<td>3%</td>
</tr>
<tr>
<td>Maximum Overlap</td>
<td>30 fields</td>
</tr>
<tr>
<td>Process in chunks of</td>
<td>Clear check box, 0 fields</td>
</tr>
</tbody>
</table>

• Ensure that the settings are as shown in the table above
• Click OK to close the dialog
• Ensure that Reconstruct and Label are the only options selected in the Pipeline dialog
• Click OK to close the Pipeline
• Click OK to close the Trial Types dialog

You may need to adjust camera sensitivity at this stage because the calibration objects use larger markers than you normally use for capture. Adjusting the sensitivity will not affect the system calibration. Also note that you should only need to perform these checks once at the start of your capture session.

• Have your markered subject stand in the Capture Volume
• Select System | Live Monitors
• Select Camera 1
• Have the subject walk to the edge of the Capture Volume furthest from Camera 1
• Select View | Diagnostic Mode
• Adjust Camera Sensitivity to the point that visible markers are stable and have at least three lines of video data
• Have the subject walk to the side nearest Camera 1
• Ensure that the markers are still spherical and are not blooming

When markers are reflecting too much light their image in the camera will sometimes distort. This causes the captured shape to be non-circular. This is called blooming. By default, the system discards all data from non-circular markers. If you need to reduce camera sensitivities to keep markers from blooming then you should check that markers are still visible when the subject moves to the far side of the Capture Volume.

• Continue the same checks on each of your cameras in turn

More details on using the Diagnostic Mode of the Live Monitors is given on page 16

A static trial is used for Subject Calibration. In preparation for the Subject Calibration ask your subject to take up a neutral pose in the centre of the capture volume. This pose should be standing, head level, feet forward, and arms at the sides with palms facing in. You can now capture data: Note that for some third party applications or modelling a specific pose is required in setting up the data to process. Check with the documentation of the application you are using for details on poses. If you are not sure, the neutral pose described above is a good starting point.

• Select Trial | Capture or click the New Trial button in the Data Directory to open the Trial Data Capture dialog

If you cannot start a trial, check that your session is open. You must have an open session in order to capture data. To open a session, double click on the session name. You should now see the name of the session in the right hand side of the Status Bar.

• Under Trial Type select the Static Trial you have created

• Under Reference enter the name you wish to use for the trial

• Click Capture

Warn the subject that capture is about to begin and that they should stand still in their neutral pose. When ready:

• Click Start

The system captures data for three seconds and begins reconstruction. On completion the white circles representing markers appear in the 3D Workspace.

The 3D Workspace is automatically opened after the capture stops.

You can see the floor represented as a grid. A set of axes indicates the
orientation of the view as defined by the calibration. You should also see the captured markers represented by white circles. If you do not then it may be that they are just not visible at the beginning of the trial.

The Time Bar can be used to replay the trial, display specific frames, set the range of interesting frames, or to set up events.

To view the trial use the Time Bar at the foot of the main window:

• To start replay click Play or press the Ctrl key and the Right Arrow at the same time
• To stop the playback click Stop or press the space bar

Alternatively you can drag the large rectangular cursor in the Time Bar ruler.

A more detailed description of data viewing options is given on page 21.

So that the system can associate captured markers with known positions or labels you must first associate a marker set with the current trial. The marker set must be compatible with the markers you have attached to the subject. If you have used the arrangements of markers described in Attaching Markers then you can use the file HumanRTkm.mkr.

To attach the marker set:

• Select Trial | Attach Marker Set....
• Locate and select the file HumanRTkm.mkr in the Models sub-folder of the main Vicon folder
• Click OK

A list of marker names will appear in the Labelling Control Bar at the right of the Workstation window. You could have specified a default marker set in the Trial Types dialog (above), in which case this marker set would already have been attached when you captured your data. To attach a default marker set to the Static Trial type:

• Select Trial | Trial Types...
• Select Static Trial in the Trial Types drop down list
• Under Default Marker Set click Browse... and locate the marker set e.g. HumanRTkm.mkr
• Click OK

The next time you perform a Static Trial capture this marker set will be automat-
Label a marker

- Adjust the workspace until you have a clear view of at least one marker you recognise.
- Move the mouse over the marker. A small window will appear showing the label for that marker - currently dashes since the marker has not been labelled.
- Click to select the marker.

It should turn yellow; if you accidentally select the wrong one, click the right mouse button to deselect and then try again.

Click on the corresponding label in the Labels List in the Labelling Control Bar.

The marker should turn light blue and a number one should appear next to the label in the Labels List. Moving the mouse over the marker now displays the label in the small pop up window. You can now continue selecting and labelling the markers. You will find, as you continue, you probably have to move around the figure, zooming in and out to make sure you can identify individual markers. You will also see that as you label more markers the green stick figure appears. How this is drawn is defined in the marker set, which includes lists of markers which combine to make body segments.

For more information on labelling see page 27.

Create the Subject Calibration:

To create a Subject Calibration in the current session:

- From the Trial menu select Create Autolabel Calibration.
- Look in the Subject Name drop down list for the name of your subject.
- If you find your subject then select the name, if not type the name in the Subject Name field.
- Under Field Range select Fields around current field and specify 0.
- Click OK.
- Select File | Save to save the trial including the labelling.

Check the Subject Calibration:

To check the Subject Calibration, verify that the Autolabel feature works for your subject. First save the trial:

- Select File | Save.

This is a precaution should you have a system failure. If this should happen then you will not have to re-label your trial. Now check the Autolabeller.
THE MOTION CAPTURE SESSION

- Select Edit | Unlabel all trajectories
- Select Trial | Options
- Verify your subject is selected
- Click OK

The name of the subject and the list of markers will appear in the Labelling Control Bar on the right of the Workstation window

- Select Trial | Autolabel or click the Autolabel button from the toolbar

The labelling may take a few moments to complete and if successful the green stick figure will be drawn. After the Autolabel is complete check that the left and right side are marked correctly. You can do this by holding the mouse cursor over any labelled trajectory to view the label assigned in the mouse helper window. As you become more familiar with the system you will begin to recognise the green stick figure.

If the markers are not labelled correctly and/or the stick figure does not appear correct please refer to the Autolabelling chapter (Page 30) for troubleshooting details.

Whenever you capture a new trial you can select the Subject in the Trial Data Capture dialog. When you do this, the subject file will be associated with the trial and there will be no need to select it in the Trial Options dialog before autolabelling. You can also use the Pipeline feature to label the trial after reconstruction.

To capture a dynamic trial:
- Select Trial | Capture or select new trial from the Eclipse Data Directory window
- Select the Dynamic Trial type that you created from the Trial Type drop down list
- Ensure the correct subject is selected in the Subjects list
- Add a description and notes in the appropriate edit boxes
- Click Capture
- Warn your subject that you are about to start capturing data
- Click Start
- When the move is complete, click Stop
Because of the options you chose in the Trial Type pipeline, you will see the reconstruction process taking place when the capture is stopped. The Autolabelling process will follow this. You will know this is complete when the green stick figure appears in the 3D Workspace window.

For more information on automation see Trial Types, Page 34 and the Pipeline, Page 40.
Three-dimensional Vicon data is produced by the combination of two-dimensional data from each camera. You can only ensure high quality results by capturing high quality two-dimensional data. Therefore it is important to check the quality of the video data at the start of each motion capture session.

The camera sensor plate senses reflected light from the markers as a series of horizontal video lines. The Datastation receives signals representing these lines and sends coordinates of the lines to the Workstation. The Workstation application uses these to calculate a central coordinate for the marker — called a centroid. How the calculation is done depends on the number of video lines:

- If there is only one or no video lines then no centroid is calculated.
- If there are two video lines then the centroid is calculated from a simple cross algorithm.
- If there are three or more video lines then the centroid is calculated using a more precise circle fit algorithm.

To get the best possible three-dimensional data all markers, in each camera view, would have at least three video lines of data, representing a stable circular shape. You can view these lines using Diagnostic Mode in the Live Monitors view for live data and in the Video Monitor for captured two-dimensional video data.

With the Live Monitor or Video Monitor open:

- Select View | Diagnostic Mode.

In this window you should see some markers represented by a number of horizontal lines. If you cannot see this then you can change the view:

- Click and drag with the left mouse button to move the view up and down or left and right.
- Click and drag with the right mouse button to zoom in and out.

By moving the view and zooming in you should be able to locate a single marker and examine the video lines.

When you are finished using checking the quality of the video data:

- Select View | Diagnostic mode again to return to the normal view.

You should use the diagnostic mode of the live monitor at the beginning of a data capture session to ensure that you are getting good quality video data. This tool can also be used with the Video Monitor to help solve problems with poor quality three-dimensional reconstructions. For example if you have captured a trial with ten markers and only reconstruct eight then you can determine whether the cause of the missing data is due to lack of video data. Alternatives would be improper reconstruction parameters or poor calibration.
The Vicon hardware captures two-dimensional video data of marker reflections in each camera. The Workstation software then takes this information and combines it with calibration data and a set of reconstruction parameters to create three-dimensional positions for each marker in the Capture Volume. The positions are calculated frame-by-frame and combined to create a complete set of trajectories of the markers positions throughout the time span of the trial.

**Reconstruction Parameters**

Ideally, the reconstruction should result in smooth and continuous trajectories – the path of each marker for the duration of the trial through the capture volume. Sometimes the captured data is incomplete – some markers not being seen by at least the two cameras required to calculate the position of each marker for each frame. When a marker is obscured from view it is called an **occlusion**. This results in broken trajectories. Sometimes markers are so close in the view that the calculation mistakes one for another, resulting in a phenomenon known as a **crossover**. Sometimes the calculation produces trajectories for markers that are not really there – these are known as ghost markers.

You can improve the reconstruction process by optimising the **Reconstruction Parameters**.

### Possible outcomes of reconstruction

<table>
<thead>
<tr>
<th>Outcome</th>
<th>Reason</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>The correct number of trajectories</td>
<td>Good calibration, no occlusions, correct reconstruction parameters</td>
<td></td>
</tr>
<tr>
<td>Too few trajectories</td>
<td>Occlusions</td>
<td>Markers blocked from view throughout trial</td>
</tr>
<tr>
<td></td>
<td>Missing markers</td>
<td>Markers have fallen off during trial</td>
</tr>
<tr>
<td></td>
<td>Improper reconstruction parameters</td>
<td></td>
</tr>
<tr>
<td>Too many trajectories</td>
<td>Occlusions</td>
<td>Intermittent occlusion means reconstruction cannot occur for some frames leading to breaks in the trajectory. These fragments are initially counted as separate segments</td>
</tr>
<tr>
<td></td>
<td>Improper reconstruction parameters</td>
<td>Reconstruction parameters mean that reconstruction cannot occur in all frames, leading to breaks and more segments (as above).</td>
</tr>
<tr>
<td></td>
<td>Ghost trajectories</td>
<td>Poor calibration results or reconstruction parameters can lead to ‘false’ reconstructions showing up as extra trajectories.</td>
</tr>
</tbody>
</table>
If you come to the conclusion that the reconstruction is unsatisfactory then you can simply run the reconstruction again:

- Select Trial | Reconstruction Parameters...
- Make changes according to Optimising Reconstruction Parameters, below, then click OK
- Select Trial | Reconstruct

The trial is reconstructed, again from the raw video data and overwrites the previous reconstruction. A message will appear indicating this.

- Click OK

### The quality of the reconstruction

There are several ways to check the quality of your 3D reconstructions. The first is to watch the left side of the status bar during the reconstruction process. This tracks the number of frames (also called fields) reconstructed. When complete it will state the number of segments created. If all trajectories are unbroken then there should be one segment per marker. If some trajectories are broken then there will be more segments than markers. This, of course, gives only an overview and you will be interested in which particular trajectories are broken.

There are three main reasons for high segment count.

- **Incorrect reconstruction parameters**
  - Incorrect choice of reconstruction parameters is a common cause of a high segment count and broken trajectories. To optimise parameters you need to revisit the Optimise Parameters dialog (see below).

- **Markers obstructed from view**
  - There are a number of situations where there is a higher risk that cameras may not be able to view all of the markers all of the time. These include capturing multiple subjects, using props or furniture in the Capture Volume, subjects bending over or rolling on the ground.

  There are a number of possible solutions. You could:
  - Reposition cameras to improve visibility
  - Use more cameras
- Use extended markers so that they are visible more of the time
- Use more, redundant, markers

Redundant markers can be used in modelling or visualisation when other markers are occluded.

Poor calibration
You will usually judge the quality of your calibration from the values of the residuals (displayed in the Calibrate Cameras dialog). You can, however get an indication from the number of segments produced during reconstruction. If a camera is accidentally moved you will see additional reconstructions causing the segment count to increase. This is why it is useful to calibrate your volume at the start and end of a capture session. If you find you have poorly reconstructed data and this is rectified by applying the later calibration it would imply that one or more cameras have indeed moved during the session.

Optimising Reconstruction Parameters
The reconstruction parameters are edited in the Reconstruction Parameters dialog. This allows you to control several parameters. These are described below but you can see how these affect the reconstruction using any of the sample data in the examples Vicon Examples database, or your own data. Because to raw 2D video data (the TVD file) is always available as the complete source data for reconstruction you should feel comfortable to experiment with different Reconstruction Parameters to find the ones that are optimal for your activity, volume, and calibration. In fact, you may want to make a practice of doing a test capture any time you change your activity or volume size significantly. This will allow you to find the optimal reconstruction parameters and verify camera placement before your subject arrives.

Reconstruction Volume
The Minimum and Maximum Vector values are the dimensions of the Reconstruction Volume in millimetres — you can view this as a purple box in the workspace by selecting View | Reconstruction Volume. For best results and fastest reconstruction you can set this volume to just enclose your Capture Volume. All data outside this volume is discarded by the calculation. This means that sources of extraneous light, such as stray markers or reflections from around the studio, can be ignored. If it is set too large, reconstruction will be slower and ghost trajectories may appear; too small and useful trajectories may be lost. As a reminder, the actual volume in which you will be able to reconstruct data is the intersection between this Reconstruction Volume and the Calibration Volume.

It is recommended that the minimum Z be set below the lowest capture point to account for unevenness in the floor.

Marker Size and Placement
During the reconstruction the software tracks the position of each marker from frame to frame, creating trajectories from marker position between frames. The
important parameter for this is the **Predictor Radius** which sets a limit to the space used in predicting where a given marker may appear in the next frame. If set to a large value the search can go further resulting in fewer breaks in the trajectory – but may also associate an incorrect marker with the trajectory causing a swap. If it is too small it results in more breaks.

The recommended value for **Predictor Radius** is half the minimum marker separation, about 30mm for normal human movement analysis. If you are using large markers you may need to increase in the **Intersection Limit**. More about the Intersection Limit is described below.

**Subject Acceleration**

The Max Accn parameter relates to how fast your subject is accelerating. This parameter is used when starting new trajectories. For most scenarios the maximum acceleration, should be left at the default value of 50 mm/s/s. If it is set too low, new trajectories will not start, resulting in missing data; too high, and points may be assigned to the wrong trajectory, especially when many markers are in close proximity.

Increase both **Max Accn** and **Predictor Radius** for fast or erratically moving subjects (for example, when analysing golf swings) and decrease them for slow ones.

**Camera Parameters and Positioning**

The **Minimum cameras to start trajectories** helps eliminate noise from stray reflections, marker ghosting and can speed up reconstruction when you have a lot of cameras. In configurations where few cameras are expected to see each marker it should be set to zero, one, or two. Please note that you should always use zero as a starting point and only increase this number if you feel confident that you are getting excessive camera contribution to marker trajectory reconstruction.

Also, positioning cameras at steeper angles say, about 38 degrees can help reduce co-linearity in feet and hands.

**Calibration Quality**

The average calibration residual (see calibrating the System) influences two reconstruction parameters. These are **Intersection Limit** and **Residual Factor**.

**Intersection Limit** is used to define the upper limit on the separation of the rays from two cameras in order for them to contribute to the reconstruction of a marker. It should be set to 12 for calibration residuals around 2.0mm or less, but increase it for higher calibration residuals and reduce it if trajectories start to crossover or fail to start.

The **Residual Factor** should be set such that multiplying by the **Intersection Limit** and then dividing by the average camera residual yields a result between 3 and 10. Higher values will cause fewer ghost trajectories to be generated but may produce spiky data as points are assigned to the wrong trajectories; lower values may give more accurate trajectories but are likely to produce more ghosts.
Hints for improving trajectories

If there are too many trajectory breaks or trajectories fail to appear at all, try increasing the Max Noise Factor (default value 7), the Intersection Limit, or the Predictor Radius. If there are too many mismatches or crossovers try reducing these parameters.

You should probably make a practice of only changing one parameter at a time however so you can determine the cause of the effect.
Workstation offers many different ways of visualising and interacting with captured data. The most frequently used tools are the 3D Workspace window and the Time Bar.

Opening a Trial
You can open trial data windows directly from the Data Directory window by double-clicking the appropriate icons:
- for Movie,
- for Analog,
- for 2D Video Monitor,
- for 3D Workspace,

or the trial name for the default view (either 3D Workspace or 3D Workspace plus Movie). You can also access these windows (as well as the Continuity Chart) from the Windows menu.

Navigation
Navigate around the 3D Workspace using the mouse:
- Drag the mouse with the left button down to rotate the viewpoint at a fixed distance about the centre. The rotation centre is marked with a purple diamond in the window. If you do not see the purple diamond select View | Rotation Center.
- Drag the mouse vertically with the right button down to zoom in and out of the space.
- Click and drag with both buttons pressed, or Control plus the left button pressed, to move the centre of the view.

Using the Time Bar to control playback
To view the motion, click Play (▶) in the Time Bar at the bottom of the Workstation window (your captured sequence will automatically loop). To stop the playback click Stop (●).

To the right of the Play button a series of buttons allow you to step through the trial frame by frame or to jump to the start and end. The slider, to the left, is normally used to control the speed of playback. Dragging to the right increases speed forwards. Dragging to the left increases speed in reverse.
If View | Real-time Playback is switched on, you can set your playback rate by adjusting the slider to any rate up to ±4.0; double-clicking on the slider restores the standard rate (1.0).

Alternatively, if View | Real-time Playback is switched on and you can select **Shuttle Mode**

- Click the **Shuttle button** ( ). (To the left of the main Play button)

You will notice the background colour of the slider changes. In Shuttle Mode the position of the slider controls the speed of playback through a single pass of the trial.

- Move the shuttle slider to the left to play at rate indicated to the start of the trial
- Move the slider to the right to play at the indicated rate to the end of the trial.

Note that it will not loop back to the start when you finish.

Click on any frame in the Time Bar to jump to that specific frame or drag the large, empty, square slider to scroll through the trial.

You can also step through the trial frame by frame using Step Forward ( ) and Step Backward ( ).

Click Previous/Next ( , ) to jump to the start or end of the trial. If events have been defined this will take you to the previous/next event instead; see the Gait Analysis scenario.

In some trials the subject may move into the capture volume after the trial has already begun and move out of the volume before the trial has ended. This is a good practice if the subject needs to "get up to speed" or you are trying to maximize the amount of data captured for a particular activity, such as the
number of gait cycles in a walking trial. In such cases there may be time at the beginning and end of the trials that has no or meaningless data in it. The Time Bar allows you to trim any unwanted frames.

The two triangular Save Range Sliders (τ) at the top of the ruler allow you to define which frames you want to save for subsequent use. The regions to discard are indicated by the purple region on the Time Bar. This is the same as selecting Trial | Trajectory Save Range... and then setting the frame numbers manually.

Double-click on a range slider to toggle the range between the first or last frames and the last user-defined frame.

If you want to only view a portion of the trial and have the particular section keep looping you can drag the Play Range Sliders ( ▪️ ▪️) to set the range for viewing. If you then click Play ( ▶️) only the portion of the data in that time range will be displayed. It can be useful when editing to replay a small section of the trial to make sure your edits are done correctly.

More accurate positioning of sliders can be achieved by zooming in on the Time Bar. Click and drag with right mouse button on the Time Bar ruler to zoom the scale.

Marking events is mostly used when studying clinical or sports motion, for example in Gait Analysis. Events are displayed as icons in the Time bar Canvas, beneath the Time Bar Ruler. The Canvas comprises three parallel lines, to display Left side, Right side and General events respectively.

- Select the Left Right or General to activate display of an event
- Click Foot Strike, Foot Off or General to apply an event at the currently selected frame
- Click Clear Events to remove all events from the current trial
Note that Plug-in Gait, available with the Science and Engineering version of Workstation can automatically detect some events. These buttons are used manually adding events to a trial.

**General viewing options: the View menu**

The View menu provides a number of options for enhancing the view in the 3D Workspace. All are toggle switches i.e. selecting them on the menu switches them on if they are off, and off if they are on. “On” is indicated by a check mark.

**Reconstruction Volume**

displays a rectangle defining the reconstruction volume described above in Reconstructing 3D Data.

**Force Plates**

displays the position of force plates if their locations have been specified in the Force Plates Setup dialog (see Capturing Analogue Data)

**Floor and Furniture**

displays the 2D grid representing the floor and, if configured, furniture. Objects such as furniture can be specified in the 3D workspace by modifying the file default.wks (found in the Vicon\Wkspace folder). The X, Y, Z coordinate axes object, although not furniture, is an example of an object defined in this file.

**Camera Positions**

displays circles representing the camera positions as calculated by the calibration.

**Camera Rays**

displays lines representing the cameras that contributed to the reconstruction of a selected marker:
• Click to select a marker

• Select View | Camera Rays

• Click with the right mouse button to deselect the marker

This can be useful when assessing the reconstruction as rays disappear when they do not contribute to a marker reconstruction. For example if one camera consistently does not contribute then there may be a problem with the camera or its calibration.

**Flicker Free:**
When Workstation is run on older computer systems and some graphics cards flicker mode will allow the data to playback faster but is harder on the eyes. Flicker Free is smoother but can be slow in playing captured data on these older computer systems.

**Always Refresh:**
Always Refresh is of more relevance to older computer systems. The playback with this setting Off will be faster and smoother but the background and furniture will be overwritten by the movement of the subject. With the setting on the screen is refreshed between frames, showing the complete screen, but slowing down the playback.

**Other Windows**
A number of other windows are available for viewing the trial data in a different ways.

**Video Monitor**
The Video Monitor is similar to the Live Monitor, but shows the captured 2D data for each camera instead of the live view. It is also different in that it has the Time Bar (which works in the normal way) and the Labelling Control Bar instead of the Camera Settings Bar. Use the numbered buttons below the main window to select cameras to view; all the View menu options available with Live Monitor also apply to the Video Monitor.

This is a great tool for trouble shooting reconstruction problems. If you are having trouble reconstructing a marker in the 3D Workspace you may want to go to the 2D video to view the raw video for each camera. If at least two cameras have captured the marker then you know the reconstruction problem lies somewhere in the calibration or reconstruction parameters. If you do not find the marker in at least two camera views then the problem is in marker placement, marker occlusion or camera positioning. In the latter case the only ways to solve the problem are to recapture the data or mathematically create this missing data.

**Continuity Chart**
The Continuity Chart is only available once data has been reconstructed, and shows which cameras contributed to the reconstruction of each trajectory. Its main purpose is to check that cameras are sensibly positioned and in...
troubleshooting reconstruction problems. This window displays each trajectory as a horizontal line. Below each line are a number of dots, each dot representing the contribution of a camera to the reconstructed data in that frame. Thus you can easily find which cameras are contributing to a particular trajectories reconstruction. Breaks in the solid line indicate that the trajectory could not be reconstructed at that point in time. This is very useful when trying to solve problems with reconstruction. For example, if one camera never contributes to any trajectory then it is either poorly placed, not well calibrated or has a mechanical or electrical problem. At this point you could decide to check the camera directly using the Video Monitor window, Live Monitors and/or check the calibration data for that camera.

**Movie**
The Movie Window displays captured Movie data in MPEG or AVI format. See Movie Capture for more information.

**Analogue Data**
See Capturing Analogue Data in System Options.
Reconstructed data consists of three-dimensional trajectories that represent the markers placed on the subject. At this stage, the software does not have a way to distinguish one trajectory from another. The process of labelling allows the software to make this distinction. This is necessary for future processing, modelling, visualisation and analysis.

The labels, and the connections between them, are stored in a text file called a marker set. Labelling is the process by which labels are assigned to specific trajectories.

There are two main methods of labelling your subject: manual labelling and autolabelling – using the Autolabel function in Workstation.

**How to assign a label**

Although you can manually label any trial, it is common practice to use a static trial. This makes it easier to recognise individual markers and have them all visible in a given frame.

The basic labelling technique is:

- In the Mode pane at the bottom of the Labelling Control Bar ensure that Label is selected.

- Select a trajectory in the 3D Workspace by clicking on the white circle that represents it. When you click it should turn yellow.

- Click the label name in the Labels List of the Labelling Control Bar.

When a trajectory is labelled it becomes a light blue colour in the 3D Workspace. If you hover the mouse pointer over a labelled trajectory a window will pop-up with the name of the assigned label and possibly the subject’s name.

**Correcting Mistakes**

You can unlabel individual trajectories using the Labelling Control Bar at the right of the main Workstation window:

- Select the trajectory you wish to Unlabel by clicking the light blue circle in the Workstation window.

- In the Control Bar, click Unlabel.
If you notice, half way through labelling that you are using the wrong marker set it, is tempting to load the correct marker set and continue. This can, however lead to markers disappearing altogether if they are different in the two sets. You should therefore unlabel all trajectories before changing marker sets. You can, at any time, unlabel all the trajectories:

- Select Edit | Unlabel All Trajectories.

**Label multiple trajectories**

Labelling trajectories one by one can be tedious – especially when you come to recognise the markers and their names easily. To speed things up, Workstation will allow the user to select multiple markers, remembering the order in which you selected them.

To label multiple trajectories:

- Adjust the 3D Workspace until you have a clear view of several unlabelled trajectories you recognise
- Select a number of trajectories, remembering the order in which you select them

Note the colours as you select them, the first yellow, then red, purple, blue and then back to yellow. You can select up to twenty markers at one time

- Click on the label corresponding to each selected marker, in the same order.

As before, the trajectories should turn light blue when labelled.

**Related topics**

Manual labelling can be tedious, particularly when trajectories are broken in several places. To automate the process, use the autolabel feature.

To label more than one subject in a trial using the same marker set see Capturing Multiple Subjects in the Advanced Capture Techniques section.
Preparing the Autolabel feature involves taking a manually labelled trial and assigning it to a subject. Behind the scenes the system stores the patterns of the marker locations on a particular subject. This process is called autolabel calibration or subject calibration and the patterns are stored in your subject file. In subsequent trials Workstation compares the patterns of markers in the 3D workspace in order to identify individual trajectories and label them automatically.

Before creating the subject calibration you must have captured and manually labelled a trial. A static trial will most often be used for this purpose though, in principle, you can use any trial.

**Autolabel calibration**

To calibrate a subject you will need to create the Autolabel Calibration in the current session:

- Move to a frame in the current trial where all the markers are present and labelled
- Select Trial | Create Autolabel Calibration
- Look in the Subject Name drop down list for the name of your subject
- If you find your subject then select the name, if not type the name in the Subject Name field
- Under Field Range select Fields around current field and specify 0
- Click OK

You have now saved the marker patterns for the current locations of the markers on your subject. These are stored in the subject file "<subject name>.sp". This autolabel calibration is only good for the current marker locations on this subject. Should markers fall off or be moved you will probably have to create a new Autolabel calibration. Finally as a precaution:

- Select File | Save to save the trial including the manual labelling

It is possible to calibrate a subject from any trial; simply stop the trial playback in a neutral pose with all markers present and labelled and perform the actions described above. It is found that better autolabel calibration is obtained if you set the field range to ± 0, even for static trials. This is especially important if using a dynamic trial, but also works for a static trial. To create an autolabel calibration from a dynamic trial:

- Stop the trial playback in a neutral pose with all markers present and labelled
- Repeat the steps given above for the static trial subject calibration
AUTOLABELLING

Create a calibration from selected trajectories

You can also produce the subject calibration from a subset of trajectories. This is useful if you wish to produce a separate subject calibration for multiple subjects in the same trial. This additional subject may be another person or an inanimate object such as a prop.

To create an autolabel Calibration when capturing multiple subjects or a subject using a prop:

• Make sure all trajectories are labelled
• Select the labelled trajectories for only one subject in the 3D Workspace
• Continue with Autolabel Calibration as described above
• In the Create Autolabel Calibration dialog ensure that Selected trajectories only is selected in the Trajectories pane.

How to capturing multiple subjects is described in more detail under Capturing Multiple Subjects in Advanced Techniques.

Defining a new subject

If you choose you can define a new subject and then create an autolabel calibration for this subject. You may choose to do this if capturing data for the same subject under different circumstances, or if markers have moved or fallen off. Remember that the subject file contains data about the subject including the marker locations and marker set used.

• Select Trial | Define Subjects...
• Click New in the Define Subjects dialog
• Enter the unique subject name when prompted and click OK
• Click Close

Now when you open the Create Autolabel Calibration dialog you can select the new subject from the Subject name list.

Using a default subject

The User Preferences dialog includes a setting to create a default subject when you create a new session.

• Select File | User Preferences
• Select or Clear Create a Default Subject

If you select the option then a new subject will be created for each session. This will be displayed in the Subject Name lists in Capture Trial and Create Autolabel Calibration dialogs as Subject.

You can still create a new the subject at the time that you create the autolabel calibration simply by specifying a new name in the Subject Name field.
**Checking the Autolabel results**

To check the autolabel results you can play the trial and look for several tell-tale signs.

**Check the green stick figure**

Check the shape and attachments of the green stick figure. As you get more comfortable working with a particular marker set you will find that you can tell a lot about the quality of the autolabel results by watching it move through your capture volume. If the shape does not look right then some labels have been applied to the wrong trajectories or some trajectories have not labelled at all.

As a side note, you should make a practice of building asymmetry into your marker sets. This asymmetry will help you determine quickly, by looking at the green stick figure, whether or not the autolabel calibration has produced good results.

**Find Unlabelled Trajectories**

You should also look for any white (unlabelled) trajectories. An easy way to locate any trajectory that may have escaped auto-labelling is to:

- Select Workspace | Next Unlabelled Trajectory

The next unlabelled trajectory will be displayed and selected. If you recognise this you can label it manually as above and repeat until all trajectories are all labelled. Note the menu option will be greyed out if there are no unlabelled trajectories in your trial.

**Using the Mouse Helper**

For a visual inspection you can hover the mouse pointer over a labelled marker. The Mouse Helper pop up window displays the label assigned to that marker. Check each marker to verify that it has the correct label. To use this feature ensure that Mouse Helper is selected in the View menu.

**Reasons for poor autolabelling**

Autolabelling can result in three likely outcomes:

- All the trajectories are labelled correctly
- None of the trajectories have been labelled
- Some trajectories remain unlabelled or are labelled incorrectly

The first is obviously the most desirable outcome but if this is not the case there are a number of possible reasons for a less than perfect result.

If no trajectories have been labelled:

- You forget to create an autolabel calibration for your subject
- Check that the correct subject has been selected for the trial (Trial | Options)
• The trial itself may be of a poor quality with a poor reconstruction, too many ghost trajectories or trajectories swapping

• The subject calibration may be poor – this can be the case if you are using frames where some markers are occluded or even missing

• The Autolabel Parameters may be incorrect (see below)

In the cases where poor data or calibration is suspected to be the reason that you got poor autolabelling you will have to recapture or recalibrate to try and improve matters. If it turns out that your subject calibration is poor you will need to create a new one. It is important to verify that the frame you are using to create the autolabel has all markers present and labelled. Refer to the section above for more information on creating the autolabel calibration.

If some trajectories remain unlabelled or trajectories are labelled incorrectly the following may be reasons:

• The patterns in your autolabel calibration are not unique

• Markers have moved since the autolabel calibration was created

• The autolabel calibration was not created from a completely labelled frame of data

• The trial itself may be of a poor quality with a poor reconstruction, too many ghost markers or markers swapping (See Data Processing)

It is important when you place the asymmetrical markers on your subject so that they are significantly asymmetrical. If they are not then there may be markers patterns that are very alike in the 3D Workspace and this which will confuse the autolabel process. Marker placement is described in Preparation.

If the attachment points of the markers on your subject move significantly (i.e. because of loose clothing or poor attachment) you will find that the patterns in your subject’s autolabel calibration no longer match the actual marker locations on your subject. In this case you will need to create a new autolabel calibration.

If you created the autolabel calibration from a frame of data that did not have all the markers present and labelled then you will need to go back and re-create the autolabel calibration.

As stated above, in the cases where poor data or calibration is suspected to be the reason that you got poor auto labelling you will have to recapture or recalibrate to try and improve matters.

**Autolabel parameters**

There are three Autolabel Parameters that can be adjusted to aid the system in auto labelling your trial from a given subject calibration. The default parameters
usually work well for autolabelling a variety of marker sets and subjects. However in some cases adjusting the following parameters will improve your auto-labelling results.

To open the Autolabel Parameters dialog:

- Select Trial | Autolabel Parameters

How the Autolabeller works

To understand these parameters it is helpful to know a little about how the autolabel feature works. As the subject moves, the separations and patterns between markers on any rigid body segment remain relatively constant while those between markers on different segments tend to change. The autolabelling algorithm works partly by testing the separations between every marker and all the others during the trial - looking for the patterns stored by the autolab calibration in the subject file. The following parameters control the execution of the autolabel feature: Maximum Deviation, Maximum Overlap and Process in Chunks.

Maximum Deviation

Maximum Deviation is the percentage deviation allowed in the separation between two markers in the dynamic trial compared to the corresponding markers in the subject calibration. The default setting is 3%. Setting this too low may result in few trajectories being labelled, too high may result in incorrectly labelled trajectories. Increase Maximum Deviation if the autolabeller is failing to recognise segments where markers are close together or there is a lot of body movement.

Maximum Overlap

Because occlusions cause breaks in trajectories, many trajectories do not exist for the whole trial. The autolabeller looks for patterns of trajectories that co-exist or overlap for at least the number of fields defined by the Minimum Overlap parameter. The default value is 30 fields. If the trial is short and very fragmented then you could reduce the overlap. If it is a long trial with a large number of continuous trajectories then increase the overlap value.

Process in Chunks

The autolabeller scans through the whole trial to determine the relationships between the markers. For long trials this can take time. The Process in chunks... option allows you to break this down into smaller sections and this increases the speed of the processing. The downside is that this increases the risk of not being able to label every trajectory. The default setting is to have this option clear. This means that the autolabel process will attempt to label every frame of data. For very long trials with good quality data you may get good auto-labelling results faster with values between 100 and 300.
There are many parameters and settings that are used to control a trial capture. Using the **Trial Types** feature you can store these settings to use for any capture session for which they are appropriate. This saves time and gives consistency during capture sessions because you only have to select the Trial Type to load the settings you desire. You can also speed up processing because a Trial Type can include settings in the Vicon Pipeline.

Trial Types have already been created and used when performing the captures in The Motion Capture Process at the start of this section. For the purpose of capturing a static trial you created or selected the **Static Trial** type, which automatically captures for three seconds only. For the subsequent capture you used the Dynamic Trial type. This allowed you to capture for as long as necessary and then reconstructed the data automatically. The Dynamic Trial type is an example of a trial type that includes some pipeline options. The Pipeline can also be used on its own and is described in detail in the following chapter.

Trial Types are defined using the Trial Types dialog, opened from the Trial menu or from the Trial Data Capture dialog.

**Default trial types: General Capture**
A number of trial types are included with the Vicon installation. They have been provided as examples but can be modified as you see fit. You can also delete trial types and create new ones. If some of the trial types described below are not on your system or have been modified you can re-create them by following these instructions and using the table below as reference.

The General Capture trial type is included with the system as an example of a very simple trial type. To look at the setting for this trial type:

- Select Trial | Trial Types
- Select General Capture in the Trial Type dropdown list

If you do not see this trial type in the list then you will have to create it. To create a new trial type:

- Click New
- Enter the Trial Type name - General Capture
- Click OK

You have now created the type. The next step is to enter the settings that will be stored under this name. The Trial Types dialog is divided into a number of panels. To create the General Capture trial type set options as directed below.
trial type just select it from the drop down list.

**Capture**
The Capture panel shows three options and allows you to select what type of data you wish to capture. You can choose any combination of Video, Analogue or Movie data – though you must choose at least one. Click to select or clear each option. For General Capture you are only interested in video data, not movie or analogue so select Video Data and clear Movie and Analogue options.

**Open Windows**
Open Windows allows you to select which windows will open after the capture is complete. By default the 3D Workspace window will open even if it is no windows are selected. Movie and Analogue options only become available if they are selected in the Capture panel. For the general capture you need not select any of these options.

**Default Duration**
Under Default Duration you can select either a fixed or an indefinite time for capture. If you select Indefinite then the system displays Start and Stop commands or enables triggering. The Time (seconds) option allows you to define a specific time for capture. The time option is useful for static trials, often used for subject calibration purposes. When creating the Static Trial type a default duration of 3s was set for this purpose. For General Capture select Indefinite.

**Default Marker Set**
The Default Marker Set box is, by default, empty and this option should be kept for the General Capture Trial Type.

This is very useful, however, to apply a marker set that is to be used for all trials of this type. This saves you having to attach a marker set after capturing a trial.

You can type the path to the marker set required, or use the Browse button to locate the .mkr file on your system.

You can also set the size of the markers used on the subject. This is used only for the display in the 3D Workspace and has no effect on the reconstruction itself.

**Sample Skip**
Sample Skip is set to the default Video Rate Divider value of 1. This setting can be used to reduce the amount of data saved. You might use this when capturing slow moving subjects or capturing for long periods.

A video rate divider of 2 will halve the capture rate of your cameras, 4 will quarter the rate and so on. The effective capture rate is shown.

For General Capture this should be set to 1.

**Post-Triggering**
*Enable post-triggering* allows the capture of something that has already happened. This can be used for capturing movements of unpredictable subjects or for unpredictable events. A typical example would be the movement of young children or animals. For the General Capture this should be left blank.

There are two main parameters: *Primary-post trigger delay* and *Secondary post-
**trigger delay.** A third, *External post-trigger delay* allows you to control the delay if you are using external triggering. With post triggering enabled the Data Capture dialog includes two extra buttons marked with the values set in the Primary and Secondary post trigger delay boxes. Data within durations specified is constantly being buffered by the system. Therefore when the event occurs, you trigger the capture but data within these periods has already been stored and is saved in the trial. You stop the trial in the normal manner.

The primary and secondary settings allow you to choose, at the time of capture how much data will be stored. When you arm the system for capture, the Data Capture dialog shows the Start button as three separate buttons. Using the default settings of 5 and 10 seconds for primary and secondary delay these would be:

- **Start** – used to start the capture without post triggering
- **5s** – used to store data 5 seconds prior to the capture being triggered
- **10s** – used to store data 10 seconds prior to the capture being triggered

For example you might be studying the movement of a young child who has just learned to walk, or want to apply such movements to a movie character. The child will be sitting and encouraged by the mother to stand and walk. You probably cannot tell when exactly the child will actually stand and start walking and so use post-triggering. You choose to use the default 5 and 10 second settings.

When you are ready you click Capture in the Trial Data Capture dialog – and wait. The child decides that they will stand and walk around the capture volume. At this point you decide how much data, before they stand, you wish to save. If nothing much has happened you click the 5s option. If the child has been making a slow standing movement you might choose to save more, and so select the 10s option.

When the movement has finished you click Stop in the usual manner.

It is important to note that this feature does not work with Movie capture.

**Options** offers four additional settings of which two are selected for General Capture: *Include subject names in labels* and *Select default or last used subject*. The former does exactly what it says and whenever you use the Mouse Helper to identify a marker or trajectory the subject name will appear in the pop up in addition to the marker label. This is especially useful if you have more than one subject. The latter is more often used when performing repeated captures using the same subject - so that you do not have to continually reselect the subject.

*Static Trial* is used by some processing operations as a flag in certain calculations for which it may be useful to know whether or not the subject is moving.
**Cue Capture from Audio file** allows audio data to be used alongside the capture and the capture may be cued from any point in the audio file, or an audio file may be started at a preset point during the capture.

**Default Trial Types: More examples**
Try selecting different Trial Types from the drop down list; you will see the settings for each change. The trial types available depend on your system. The default settings for some of these are detailed in the Table below.

You can use any of these trial types or use them as a starting point to create for your own. To modify them you might rename them or simply change the settings.

<table>
<thead>
<tr>
<th>Type</th>
<th>Capture</th>
<th>Open Windows</th>
<th>Default Duration</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Video</td>
<td>None</td>
<td>Indefinite</td>
<td>None</td>
</tr>
<tr>
<td>Movie only</td>
<td>Movie</td>
<td>Movie Data</td>
<td>Indefinite</td>
<td>None</td>
</tr>
<tr>
<td>Pipeline Capture</td>
<td>Video</td>
<td>3D Workspace</td>
<td>Indefinite</td>
<td>Include Subject names in labels Select Default or last used subjects</td>
</tr>
<tr>
<td>Subject Calibration</td>
<td>Video</td>
<td>None</td>
<td>Time = 3s</td>
<td>Static Trial Include subject names in labels</td>
</tr>
<tr>
<td>Timed Capture</td>
<td>Video</td>
<td>None</td>
<td>Time = 1s</td>
<td>Include subject names in labels Select Default or last used subjects</td>
</tr>
<tr>
<td>Video and Analogue</td>
<td>Video</td>
<td>None</td>
<td>Time = 5s</td>
<td>Include subject names in labels Select Default or last used subjects</td>
</tr>
<tr>
<td>Video and Movie Capture</td>
<td>Video</td>
<td>Video monitor Movie data</td>
<td>Indefinite</td>
<td>Include subject names in labels Select Default or last used subjects</td>
</tr>
</tbody>
</table>

To rename a Trial Type:

- Open the Select Trial | Trial Types to open the dialog
- Select the type you wish to rename from the Trail Type drop down list
- Click Rename
• Type the new name in the pop up dialog and click OK
• Click OK to close the Trial Types dialog

Edit a Trial Type
To change any of the settings for a trial type:
• Select Trial | Trial Types to open the Trial Types dialog
• Select the type you wish to edit from the drop down list
• Change any settings, as appropriate
• Click OK

Delete a Trial Type
To delete a Trial Type:
• Select Trial | Trial Types to open the Trial Types dialog
• Select the type you wish to delete from the Trial Types drop down list
• Click Delete...

You will be prompted to confirm that you do indeed wish to delete the type. On clicking yes the drop down list will be refreshed. Finally click OK to close the dialog.

Some common uses of the Trial Types feature
This section serves to reiterate some of the uses of the trial types feature. Trial types are used to store settings for specific capture protocols. These can then be used, with a couple of clicks of the mouse, instead of resetting every parameter every time. Note that trial types are greatly enhanced by the use of the Vicon Pipeline. This stores data processing options. More about the Pipeline is discussed in the next chapter.

In each of the following examples the capture and processing options could be selected on a trial-by-trial basis but the trial types feature allows these settings to be selected consistently, quickly and easily for many trials:

• Subject Calibration or static trial capturing video data for three seconds only
• Trials involving capture of specific combinations of data; video, movie or analogue
• Timed Capture for predictable situations such as the static capture
• Using Post-Triggering for unpredictable trials such as children or animals
• Including a specific marker set for a number of trials
TRIAL TYPES

- Using Sample Skip to alter the capture rate
- Adding pipeline options, for example to always reconstruct and label the subject, analyse, save and export
The Pipeline offers a method of automating your motion capture and data processing.

The pipeline can be used in three different situations:

- Immediately after capture in conjunction with a trial type
- On an open trial
- On a group of selected trials

The pipeline allows you to set a number of processing options such as reconstruction and labelling. These options may be included in a trial type so that they are run every time the type is used. Alternatively, you can open the pipeline dialog for any trial, set the options and run them directly. If you have captured a lot of data in several trials and want to process these later, you can select these trials in Eclipse and run the pipeline as a batch process.

A number of pipeline options are available with every system. You may also have purchased any of a number of Vicon plug-ins or have created your own plug-ins. These are specific data processing modules such as Plug-in Modeller and Plug-in Gait. When these are installed with your Vicon system, they will appear in the Pipeline dialog and are run as pipeline processes.

**Default pipeline: capture and reconstruct data**

A number of useful default trial types that include pipeline options are included with the Vicon installation. In the example earlier in this chapter, you might have looked at some of the settings for the Pipeline capture trial type.

If you used the Pipeline trial type, immediately after stopping capture, you would be able to observe Workstation going through the motions of reconstructing the data and autolabelling (look at the status bar). When complete, the 3D Workspace window should open and the green stick figure should appear in the 3D Workspace window.

Take a look at the Pipeline dialog (below) to see what was done here. This may be opened directly from the Trial menu or by using the Pipeline button in the Trial Data Capture and the Trial Types dialogs.

The dialog displays the list of pipeline options available in your version of Workstation. You may have more or fewer options in your pipeline depending on the software packages you purchased and any plug-ins you have created or acquired. In this example, the pipeline included the Reconstruct and Label options. Each selected option is processed in logical order.
Using the pipeline

The pipeline is a very simple dialog, comprising a list of available features. To set a pipeline option:

- Open the Pipeline dialog either from the Trial menu, the Trial Types dialog or the Trial Data capture dialog
- Click the selection box next to the function you wish to run
- When selected a tick (check mark) appears in this box. Click again to clear the selection and turn off remove the pipeline function

If appropriate, as seen in the figure above, you can make multiple selections. If you have a trial open then you can click Process now to run the Pipeline on that trial.

Some functions have a series of options available. For example for Reconstruction you can set the reconstruction parameters to be used. To set the options:

- Click the text of the required function
- Click Options...

The appropriate Options dialog opens. Set the parameters and close the dialog to return to the pipeline.

When you click the name of the function it will be highlighted but not selected as a pipeline function. If you click the selection box to the left it will be selected as a pipeline option and highlighted at the same time.

Repeating captures

One very useful Pipeline option is Capture Next Trial. This is usually used in
conjunction with a trial type. This option can be a practical solution to the problem of having to capture a lot of data in a short time, when you know the moves to be made and you do not have time to process and clean up data while in the studio.

You may be able to find the Repeated Capture type in the list in the Trial Types dialog. To view the details of this trial type:

- Select Trial | Trial Types
- Select Repeated Capture from the Trial Type drop down list

If you do not see this trial type you may want to create a new one with the options discussed below. For more details on creating Trial Types please reference the previous chapter.

- Click Pipeline

The Pipeline dialog opens. If necessary, scroll down until you find the single selected item: Capture Next Trial.

Now:

- Select the text Capture Next Trial so that it is highlighted in blue
- Click Options...

This opens the Capture Next Trial options dialog. This offers two options:

**Display Trial Capture dialog**

If you select Display Trial Capture dialog, after the trial capture is complete the Trial Data Capture dialog will be displayed automatically allowing you to confirm or change the settings before capturing the next trial. This saves time and keystrokes.

**Use settings from last captured trial**

Selecting Use settings from last trial causes the system to move directly onto the next trial start dialog. This new trial uses the settings already entered, and automatically augments the trial name by one. When you have finally completed your set of captures click Cancel in the Data Capture dialog to break the cycle.

**Set Pipeline options**

Most of the options available in the pipeline dialog have their own set of parameters. The dialogs used to control these parameters are available from within the pipeline dialog itself – using the Options button. For example to set reconstruction parameters:

- Select Trial | Pipeline
- Select Reconstruct so that the text is highlighted
• Click Options…

Complete the dialog, as you would normally do so and close to return to the Pipeline dialog. Note that when you select an option, some explanatory text appears in the panel at the bottom of the dialog window.

The pipeline can be used on an individual trial. To run selected pipeline options on an open trial:

• Select Trial | Pipeline to open the pipeline dialog
• Select the options you wish to run
• Click Process Now.

If you were to use a trial type such as the Repeated Capture example you could produce a lot of trials that need to be processed. It is usually a good idea to process one or two of the trials manually in a step-by-step fashion so you can check the quality of your data and verify what the appropriate settings are. Having done this you can batch process all of the trials through the same pipeline:

• Open the Eclipse Data directory window by pressing F2
• Locate several trials in a calibrated session which are ready for reconstruction and autolabelling
• Right click each of the required trials and select Batch Process from the short cut menu
• Select Pipeline from the Trial menu in the main Workstation window
• Select Reconstruct and Label from the list of pipeline processes, choosing appropriate options.
• Click Process Now

The data processing log opens and details the progress of the pipeline (see below). This is useful if things go wrong during the pipeline process. When complete you will be asked whether you wish to save the changes the trials individually. There is also a pipeline option for saving the trial. If you choose this option the processed trials are saved automatically. You can select as many trials as you wish to batch process – so it is quite possible to spend a day in the studio capturing data and then leave your system to process the data over night.

We recommend checking the quality of each individual trial after batch processing.
To save time when selecting trials for batch processing you can select a whole session:

- Right click a session that is ready for processing and select Batch Process from the shortcut menu.

This should select every trial within that session and display a red tick by each one. Now when you run the pipeline every trial will be processed in turn. The log will display when each trial is opened for processing.

**The processing log**

The processing log is a text file log.txt usually stored in the System sub-folder of the main Vicon installation folder. The file is displayed by default when you use the pipeline to process a number of trials for batch processing in the Eclipse Data Directory window.

During the pipeline process you can click:

- Pause and Resume to temporarily halt and restart the pipeline
- Stop to terminate at a specific point
- Cancel to stop the process without saving any changes

When the pipeline has finished

- Close to close the log file window
- Clear to empty the contents of the log file
- Browse to locate the log.txt file if it has been saved to a different location

Notice that the log file appends any new information to the bottom of the current log file, so you will have to scroll to the bottom each time to see the latest information. It may be useful to clear the contents from time to time. You will be asked to confirm this action. If you wish to save the file for your records then the file may be renamed in the normal manner using the Windows utilities.

Whether or not you wish to view the log file is a matter of user preferences:

- Select User preferences from the File menu

In the bottom right of the User Preferences dialog a small panel labelled Open Processing Log Window. This offers any or all of the three selections:

  - After Capture
  - Running pipeline on an open trial
  - Running pipeline on selected trials
The default setting has the window displayed only when the batch processing option is being used.

You can also view the Processing Log at any time by go to View | Processing Log on the menu.

The following merely provides a reiteration of some of the common uses of the pipeline:

As part of a trial type to provide specific processing options immediately after capture, In the example trial types:

- **Subject Calibration** includes reconstruction in the pipeline
- **Pipeline Capture** includes reconstruction and labelling
- **Repeated Capture** includes Capture Next Trial

Create your own pipelines as part of a trial type, for example:

- To process a trial for gait analysis using the Plug-in-Gait options (if available)
- To automatically save trials when they are captured
- For repetitive work such as short timed trials where you do not want to go through the complete process of specifying capture parameters

For efficient off-line processing of multiple pipeline options on a single trial

For off-line processing of multiple trials including:

- Reconstruction and labelling
- Modelling for gait analysis or kinematic fitting
- Export of files to ASCII and CSM
CLEANING UP DATA

Ideally each marker on your subject will be reconstructed to produce a smooth trajectory throughout the trial. Unfortunately there will frequently be frames where some markers cannot be reconstructed leading to breaks in trajectories. There may also be some spurious data; phantom markers and ghost trajectories and odd spikes (points in trajectories that clearly do not lie on the general curve). This chapter describes the nature and sources of typical problems and how to edit your data to correct them.

Types of problem in 3D data

Broken trajectories
Broken trajectories are the most common problem. They arise from markers being hidden from sufficient camera views such that Workstation cannot reconstruct the trajectory at that point. This is known as occlusion and can occur, for example, when a body segment, subject or prop obscures the marker. An example would be when a subject bends over at the waist. If all your cameras are mounted above head height then the chest markers might be occluded by the subject’s own body. If you have more cameras and optimise their position for a given task then this is less likely to cause a problem.

Phantom markers
Phantom markers are recognised as single markers some distance from the main subject, often near the edge of the capture volume and only visible fleetingly during playback. These appear rarely, when rays from two coplanar cameras intersect each other at more than two locations. The result is multiple reconstruction points manifesting as extra markers.

Ghost trajectories
A ghost trajectory can be recognised as an additional trajectory very close to an existing one, appearing over a short duration. The real and the ghost trajectory are usually separated by a value similar to the Intersection Limit (set in the Reconstruction Parameters dialog). This parameter is related to the calibration results and either may be the cause.

Unlabelled trajectories
Unlabelled markers may be phantom markers, ghost trajectories or trajectories that the autolabeller has missed. How many of these you have are indicated in the Unlabelled pane of the Labelling Control Bar when the 3D Workspace is open for a given trial. This displays the number of unlabelled trajectories in the current frame and in the whole trial.

Blooming, flickering and merging
Blooming, flickering and merging are all manifestations of poor video data. This may be a consequence of not taking enough care to set the apertures and sensitivities of cameras correctly. Blooming occurs when a marker is close to a camera with a high sensitivity. The system may interpret the high intensity of the reflection as two smaller markers and derive two false centres. Flickering occurs in the opposite situation – a marker some distance from a camera with low sensitivity. It may appear to be coming in and out of view and the reconstructed point consequently flickers. Merging is two markers, quite close to each other, appearing as a single marker. There are two common causes; two markers already close to each other being aligned in the view of one camera, and too high sensitivity.
These problems relate in general to 3D data quality and cannot be used to clean data at this point. If you have an excess of blooming flickering or merging you may need to plan your capture out more carefully and capture data again.

Crossovers occur during reconstruction when markers pass very close to one another and the two trajectories become collinear. When they separate they may then be mislabelled – swapping to the incorrect trajectory.

Crossovers are more likely to occur in trials where markers come in very close proximity to each other. In general if markers are placed correctly, a good calibration is obtained and suitable reconstruction parameters are used then they should not be an issue. The Intersection Limit and Predictor Radius are key parameters in avoiding crossover problems.

Diagnosing the cause of problems

If only two or three cameras are contributing to a reconstructed trajectory then it is likely that the break is due to an occlusion. If you there are several cameras contributing, then poor reconstruction parameters is the probable cause.

There are two simple ways to assess the number of cameras contributing to a reconstruction.

The first is to use the View Camera Rays and View Cameral Positions features, both found in the View menu when the 3D Workspace window is open.

- Open a trial that has been reconstructed
- Select a trajectory of interest
- Select View | Camera Rays

A number of straight lines appear, attached to the trajectory you have selected. The lines are colour coded in the same order as markers and indicate which cameras are contributing to the reconstruction. To identify cameras select View | Camera Positions and zoom out to see labelled circles representing cameras. As you step through the trial you will see rays disappear when no contribution is being made.

The second is to use the Continuity Chart:

- Select Window | New Continuity Chart

This displays trajectories as straight lines below which are displayed series of dots. The dots indicate the number of cameras contributing to the reconstruction in each frame. This is easy to use as all trajectories are parallel lines and it is easy to scan through to locate breaks. Locate the break and check which cameras were contributing to the trajectory just before the gap occurs.
The most certain way to determine whether reconstruction parameters or lack of complete 2D video data is to blame for poor 3D data is to check the video data in the Video Monitor window for the period of time in which there is a break. Remember there must be video data for a given marker in at least two camera views in order for the system to be able to reconstruct any 3D data.

If it is determined that the poor 3D data is the result of improper Reconstruction Parameters the best way to start cleaning up the data is to go back, change the Reconstruction Parameters and then re-reconstruct the 3D data.

**Loss of calibration**

The loss of calibration in one or two cameras is most obviously seen as an increase in the number ghost trajectories. To be sure of these open a new continuity chart and locate the ghosts. You will notice that the same cameras are contributing to these trajectories. The best solution is to open a new session and recalibrate.

**The subject walks out of the volume**

If the subject is moving near the edge of the capture volume then they may accidentally walk out and back inside. This is easy to spot since you will be able to see this during playback. The solutions to this are either recapture the trial or remove the unwanted data. The latter can be achieved by using the save range markers on the Time Bar Ruler.

**Unlabelled markers**

Visual inspection should tell you whether an unlabelled trajectory is useful data missed by the autolabeller or a phantom or ghost trajectory.

Unlabelled trajectories are white whilst labelled trajectories are light blue. Phantoms and ghosts may be less obvious, as they only appear for short periods and may be far from the main subject or lost in the mass of other trajectories. Fortunately Workstation has tools to locate them for you. The following instructions assume you have reconstructed and labelled your data as described in the sections above. If there are no unlabelled trajectories in your trial then the menu options and icons discussed below are greyed out.

- Click the Next Unlabelled Trajectory icon:
- Select Workstation | Next Unlabelled Trajectory
- Press F10

Any of these will locate and select the next unlabelled trajectory and highlight in yellow. If you think you have missed a trajectory locate the previous unlabelled one:

- Click the Previous Unlabelled Trajectory icon:
- Select Workspace | Previous Unlabelled Trajectory
- Press Shift+F10
CLEANING UP DATA

The purple rotation centre will appear at the centre of the trajectory, allowing you to zoom in and move around. If you have already defragmented your trajectories then the rotation centre may appear at the origin of the Workspace. This means that the centre of the trajectory is actually a gap. In this case use the Step Forward or Step Back buttons in the Time Bar until you see the yellow labelled trajectory. You may also find it useful to use the triangular sliders to extend the range of the visible trajectory.

You can also use the Continuity Chart to view unlabelled trajectories. Here all trajectories are laid out in order and you do not have to struggle through the mass of other trajectories. Ghosts and phantoms will be apparent due to their short lifetimes. You can find and select trajectories in the same way you do in the 3D Workspace. That is, as you click on the trajectories they will change colour as the do in the 3D Workspace. Also, you can switch between the two views and the selections of the trajectories will remain.

Crossovers

If there are many crossovers check that markers are correctly located on the subject. You should also check the reconstruction parameters, in particular the Intersection Limit and the Predictor Radius (Reconstruction Parameters are discussed in The Essentials of Motion Capture). You should also check the calibration residuals. For residuals of 2mm or less the recommended Intersection Limit is 12. If this is higher it may lead to more crossovers in your data. The recommended value for the Predictor Radius is half the minimum marker separation – normally around 30mm for normal human movement. A high value can lead to more crossovers.

Viewing trajectories

Before editing data it will be useful to familiarise yourself with methods of viewing trajectories. One of the easiest ways is to use the Continuity chart. Because each trajectory is presented as a straight line it is simple to scan through and see where breaks occur. When fixing breaks, however, it is useful to be able to see the shape of the trajectory. To do this, view the 3D Workspace and use the two small sliders on the main slider to extend the range of visible trajectory. When you use the Find Next Gap command, Workstation automatically extends the visible range to ±10 frames.

It is useful to zoom in and look closely at the breaks in a trajectory though you may find the presence of all the other trajectories confusing. You can display only selected trajectories:

- Select Workspace | Hide Other Trajectories

If no trajectories are initially displayed:

- Click to select the desired trajectories

- Select Workspace | Show Trajectories
You can also select trajectories using the Labels List in the Labelling Control Bar:

- Click Select in the Mode panel at the foot of the Labelling Control Bar
- Select the label names in the Label List for trajectories you wish to view
- Select Workspace | Show Trajectories

To hide only selected trajectories:

- Select Workspace | Hide Trajectories

To hide all trajectories:

- Select Workspace | Hide All Trajectories

To display all trajectories:

- Select Workspace | Show All Trajectories

Another useful tool is the Select Centre command. When you zoom in to view the workspace at close quarters and drag to rotate the view, the rotation still occurs around the centre of the Workspace – which can result in you losing the subject from view altogether. You can see the centre of rotation as a purple marker when Rotation Centre is selected in the View menu. You can make a specific marker the centre of rotation so that any rotation occurs around that marker and you do not lose the subject from view:

- Select the marker to use as the centre of rotation
- Select Workspace | Select Center

The centre of rotation is moved back to the centre of the Workspace when you click Play in the Time Bar.

**Editing 3D Data**

The first part of this section describes how to reconstruct and autolabel your data. If you have perfect 3D data then you are ready to go on to the next step of visualising, modelling, analysing, or applying your data to an animated character. If however your data is not exactly perfect at this point then you will need to edit and clean it up some before moving on. The general steps for cleaning and editing data are:

- Label any unlabelled trajectories of interest
- Delete remaining unlabelled trajectories
CLEANING UP DATA

- Check trajectory fragments
- Defragment trajectories
- Delete any erroneous overlaps
- Check for crossovers
- Check for gaps in data
- Fill small gaps
- Use Copy Pattern to fill larger gaps
- Use Delete and Delete & Fill to remove spurious data points in trajectories

You may not need any of these steps or you may need them all depending on the state of your data. It is important to remember that extensive data cleaning and editing can take a lot of time. The Vicon system has been designed to give very clean data that requires little or no editing when used correctly. If you find yourself doing a lot of cleaning and editing you may want to take some time and go over your capture set-up and techniques as described in earlier sections. It is often true that 30 extra minutes spent in optimising your camera set-up and capture protocol saves numerous hours of cleaning and editing.

Having located unlabelled trajectories and decided whether they are useful data or ghosts and phantoms there are two options:
- Manually label good trajectories
- Delete unwanted trajectories

To manually label a trajectory:
- Locate and select the trajectory
- Click on the label name in the Labels list

To delete an unwanted trajectory:
- Locate and select the trajectory
- Select Edit | Delete Trajectory

If you are certain that all the unlabelled trajectories remaining are ghosts and phantoms you can delete them all together:
- Select Edit | Delete Unlabelled Trajectories

Ghosts and phantom trajectories

Defragment Trajectories  As discussed above, trajectories may break during reconstruction resulting in more segments (trajectories) than you actually have on your subject. In some
cases the trajectories are portions of the same trajectory that are merely separated by a break in the data and their position in time.

For example if the shoulder marker is reconstructed for several frames, then occluded for a couple of frames, and then is reconstructed again for several frames then two trajectories will be created. One trajectory will be created for the shoulder marker before the break and one for the shoulder marker after the break. Since by default, the autolabel routine tries to label each frame of data, both trajectories will be labelled as the left shoulder.

You can see the number of such trajectories immediately after autolabelling. A number to the left of the label in the Label List will indicate the number of such similarly labelled trajectories. The process of combining these multiple trajectory fragments into one long trajectory is called **defragmenting**. You should always defragment any fragmented trajectories. Before defragmenting however you may want to look at the fragments and verify that they have been labelled correctly.

If there are no such breaks then the number next to each label being used should be 1.

If you have fragmented trajectories you can join them together using the Defragment command:

- Select Edit | Defragment Trajectories

All trajectories with the same label are joined together by aligning them. This can be easily seen by looking at a fragmented trajectory in the Continuity Chart as you defragment. A message will appear after defragmenting indicating how many trajectory fragments were joined and if any overlaps resulted.

Where overlaps in trajectories occur the overlap is saved as a separate trajectory with a label based on the original. You may then delete this, or if mistakes have been made (such as mislabelling) use it to repair the data. You will want to use or remove overlapping trajectories before moving on. To delete an overlapping trajectory:

- Find and select the trajectory in the Continuity Chart
- Go to Edit | Delete trajectory <overlapping trajectory name>

Note that when the trial is saved to disk trajectories are automatically defragmented.

**Crossovers**

Crossovers may be found by visual inspection. Perhaps the first clue will be that during playback the green stick figure will change unexpectedly. Where the crossover occurs, the link between markers will change as the labelling changes between the trajectories. You may inadvertently cause a cross over if you do not verify the labelling of trajectory fragments before you defragment. To locate the
crossover accurately:

- Select the two trajectories suspected of crossing over
- Select Workspace | Hide Other Trajectories
- Adjust the visible trajectory range using the two small sliders attached to the main slider on the Time Bar
- Play back the trial in slow motion, or step through a frame at a time

The crossover will appear as a definite exchange between two trajectories where you would expect them to carry on smoothly. If you wish to create a false crossover, just to see what one looks like:

- Select two trajectories (preferably two that are naturally close together)
- Select Workstation | Show Trajectories to display only these
- Adjust the visible trajectory range using the Time Bar
- Zoom in on the trajectories to improve your view
- Click to select a distinct position on the second trajectory selected
- Select Edit | Exchange Points

The result is that the selected point and the matching point on the first trajectory are exchanged, creating a crossover. Of course this feature is really designed for fixing crossovers but this will give you an idea of what you are looking for.

If the crossover occurs at a single point then you may be able to fix it using the Exchange Points command:

- Select one of the crossover trajectories
- Select the second crossover trajectory
- Select the second trajectory at the point where the crossover occurs
- Select Edit | Exchange Points

If you select the correct point then the crossover will be fixed directly. If you are unable to locate the crossover point easily, or the crossover is more complex you will need to ship the trajectories, relabel and then defragment.

This example assumes a crossover between two markers LFIN and LTHI and is illustrated over page.
• Select the first trajectory e.g., LTHI at a position just before the crossover starts

• Hold down the Control key and select the same trajectory just after the crossover

• Select Edit | Snip Trajectory: LTHI

This removes all points between the two selected. Repeat this for the trajectory LFIN:

• Select the second trajectory, LFIN at a position just before the crossover starts
• Hold down the Control key and select the same trajectory just after the crossover

• Select Edit | Snip Trajectory: LTHI

This removes all points between the two selected. Repeat this for the trajectory LFIN:

• Select the second trajectory, LFIN at a position just before the crossover starts

• Hold down the Control key and select the same trajectory just after the crossover

• Select Edit | Snip Trajectory: LTHI

The crossover section of this trajectory is also removed. The next steps are relabelling, defragmentation and filling the gaps:

• Click Select in the Mode panel of the labelling control bar

• Select the segment of LTHI after the break

• Click Unlabel

• Select the segment of LFIN after the break

• Click Unlabel

These unlabelled segments should be displayed white as compared to the blue for labelled trajectories.

• Click Label in the Mode panel of the Labelling Control Bar

• Select the unlabelled segment that was incorrectly labelled LFIN

• Label it LTHI

• Select the unlabelled segment that was incorrectly labelled LTHI

• Label it LFIN

Now defragment to ensure that Workstation recognises all identically labelled segments as belonging to the same trajectory:

• Select Edit | Defragment Trajectories

You can now fill the gaps in the trajectories as described below.
CLEANING UP DATA

Fill Gaps: small gap fixing

After defragmenting you may find that you have gaps in your trajectories where the fragments were joined. Because gaps in defragmented trajectories are common problems, the tools available for fixing them are comprehensive, giving you complete control over how you handle them. The tools are all found in the Edit menu, though you will also use the tools in the Workspace menu to find the gaps.

After defragmenting you may find that you have gaps in your trajectories where the fragments were joined. Because gaps in defragmented trajectories are common problems, the tools available for fixing them are comprehensive, giving you complete control over how you handle them. The tools are all found in the Edit menu, though you will also use the tools in the Workspace menu to find the gaps.

Fill a single gap:
- Select Workspace | Find Next Gap to locate the next break in the selected trajectory. Workstation centres on the break and selects the point on either side.
- Select Edit | Fill gaps in [name of selected trajectory]

Workstation fills the selected gap using a cubic spline interpolator.

Fill several gaps in a selected trajectory:
- Select a trajectory with a gap
- Select Edit | Fill Gaps In [name of selected trajectory]

Fill gaps in a selected range:
- Select a trajectory
- Click to select the first point in the range
- Holding down the Control key press the last point at the range

The two ends of the range are highlighted with crosses.
- Select Edit | Fill Gaps In [label of trajectory]

Filling all gaps in all trajectories
- Select Edit | Fill All Gaps

Only gaps below the maximum fill size will be filled. Define the maximum size of gaps to be filled.

Define the maximum size of gaps to be filled
The cubic spline interpolation used to fill gaps can give unrealistic results if used on large gaps. You should therefore set a maximum gap size for the Fill Gaps method:
CLEANING UP DATA

- Select Edit | Maximum Fill Gap

- Set the maximum size as an integer in the "Restricted to (samples)" field

You can alternatively select No Restriction to allow this method to be used for all gaps. This should only be used if you know that all the gaps are fairly small. A better method for fixing large gaps is the Copy Pattern method (see below).

After performing a Fill Gap command look closely at the three-dimensional movement to check that the result looks realistic. If not you can use the edit menu to undo the fill.

**Copy Pattern: large gap fixing**

The Copy Pattern command, also found in the Edit menu, is used to fill large gaps by copying the points from a similar trajectory. To decide which trajectory to copy from view the trajectories on the same body segment as the broken trajectory:

- Select each trajectory in turn

- Select Workspace | Show Trajectories

A visual inspection will indicate which trajectory most closely follows that of the broken trajectory. When you decide which one to use:

- Select the ends of the gap in the trajectory you wish to copy to

You can do this by extending the trajectory paths as described above under "Viewing trajectories". Once the path of the trajectory with the gap is extended to the point that you can see data on both sides of the gap then you can click on both ends of the gap. Hold the "Ctrl" key down while you select the second point. If you have done this correctly you should see a white cross at end of the gap in the selected trajectory. A more efficient way to do this is to use the "Find Next Gap" command on the Workspace menu.

- Click anywhere on the trajectory you wish to copy from

- Select Edit | Copy Pattern

After performing a Copy Pattern you should look closely at the three-dimensional movement to ensure that it is correct. If it is clearly wrong you can use the undo feature.

**Specific points**

You may occasionally come across odd points or sections of trajectories that are clearly at odds with the main flow – spurious points and overlaps. These often occur near the start and end of a trial and it may be prudent to remove these data rather than allow them to lower the quality of the whole trial or to cause problems with other editing processes such as defragmentation.

To delete a single point:

- Locate and select the point in the trajectory
CLEANING UP DATA

- Select Edit | Delete Point

The point, highlighted with a white cross, is deleted. To delete a range of points:

- Select the first point in the range
- Holding down the control key <Ctrl> select the point at the end of the range
- Select Edit | Delete Points

This will leave you with a gap in your trajectory. For single points or short gaps you can perform the deletion and fill the gap by cubic spine interpolation:

- Select the point or range to be deleted

Select Edit | Delete and fill

Using BodyBuilder for data editing

BodyBuilder is a companion to Workstation that, if purchased, enables you to edit and manipulate Vicon data. Key features are:

- Edit, modify and create new points and trajectories
- Interpolate broken trajectories
- Filter and resample data
- Create kinematic models and calculate model parameters
- Model body segments and joints
- Export results to ASF format for import by animation packages

These features combine to make BodyBuilder an important tool for those interested in biomechanics and those interested in using captured motion for animation. BodyBuilder includes its own comprehensive user manual that describes the editing and modelling tools in detail. Please refer to this manual for further information about editing and cleaning data with this product.
INDEX

A
Always Refresh 25
Analogue window 26
Autolabel Calibration 29
  checking results 15
Autolabel parameters 32
    recommended values 09
Autolabelling 29

B
Batch processing 43
Blooming 10
BodyBuilder
    for data editing 58

C
Calibration
    loss of 48
    quality and segment count 17
Camera Positions
    viewing in 3D Workspace 24
Camera Rays
    viewing in 3D Workspace 24
Camera sensitivity 09
Capture
    dynamic trial 13
    next trial 41
    static trial 10
Clean up
    using BodyBuilder 58
Continuity Chart 26
Copy
    pattern 57
Crossover
    definition 47
    fixing 49
    locating 47

D
Default Marker Set 35
Defining a new Subject 29
Defragment Trajectories 52
Delete
    a single point 57
    trajectory 51
    unlabelled trajectories 50
Dynamic trial capture 13
E
External post-trigger delay 35

F
Find Next Gap 49
Fix
large gaps in trajectories 57
small gaps in trajectories 56
Fix crossover 49
Flicker Free 25
Floor and Furniture
viewing in 3D Workspace 24
Force Plates
viewing in 3D Workspace 24

G
General Capture 34
Green stick figure
sudden change of 52

I
Intersection Limit 19
and crossovers 47

L
Label markers 12
Labelling
multiple trajectories 28
trjectories 27
Loss of calibration 48

M
Markers
unlabelled 48
Max Accn 19
Max Noise Factor 20
Maximum
vector 18
Maximum Deviation 33
Maximum Fill Gap 57
Maximum Overlap 33
Minimum
vector 18
Movie window 35
Multiple gaps
filling 57

N
No Restriction 56
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Occlusion</td>
<td>16</td>
</tr>
<tr>
<td>Open Database</td>
<td>04</td>
</tr>
<tr>
<td>Optimise</td>
<td>16</td>
</tr>
<tr>
<td>reconstruction parameters</td>
<td>16</td>
</tr>
<tr>
<td>Phantom</td>
<td>46</td>
</tr>
<tr>
<td>Pipeline</td>
<td>40</td>
</tr>
<tr>
<td>offline processing</td>
<td>43</td>
</tr>
<tr>
<td>Play Range Sliders</td>
<td>23</td>
</tr>
<tr>
<td>Post-Triggering</td>
<td>35</td>
</tr>
<tr>
<td>Predictor Radius</td>
<td>19</td>
</tr>
<tr>
<td>and crossovers</td>
<td>47</td>
</tr>
<tr>
<td>Primary-post trigger delay</td>
<td>35</td>
</tr>
<tr>
<td>Problem</td>
<td>47</td>
</tr>
<tr>
<td>diagnosing cause of</td>
<td>47</td>
</tr>
<tr>
<td>types of</td>
<td>46</td>
</tr>
<tr>
<td>Process in Chunks</td>
<td>33</td>
</tr>
<tr>
<td>Processing log</td>
<td>43</td>
</tr>
<tr>
<td>Reconstruction Parameters</td>
<td>16</td>
</tr>
<tr>
<td>about</td>
<td>16</td>
</tr>
<tr>
<td>as cause of problems</td>
<td>46</td>
</tr>
<tr>
<td>optimising</td>
<td>16</td>
</tr>
<tr>
<td>recommended values</td>
<td>07</td>
</tr>
<tr>
<td>Reconstruction quality</td>
<td>17</td>
</tr>
<tr>
<td>segment count</td>
<td>17</td>
</tr>
<tr>
<td>Reconstruction Volume</td>
<td>18</td>
</tr>
<tr>
<td>Residual Factor</td>
<td>18</td>
</tr>
<tr>
<td>Sample Skip</td>
<td>35</td>
</tr>
<tr>
<td>Save</td>
<td>23</td>
</tr>
<tr>
<td>range</td>
<td>23</td>
</tr>
<tr>
<td>trial</td>
<td>45</td>
</tr>
<tr>
<td>Save</td>
<td>43</td>
</tr>
<tr>
<td>batch processing</td>
<td>43</td>
</tr>
<tr>
<td>Secondary post-trigger delay</td>
<td>35</td>
</tr>
<tr>
<td>Segment count</td>
<td>17</td>
</tr>
<tr>
<td>causes of</td>
<td>17</td>
</tr>
<tr>
<td>Show Trajectories</td>
<td>49</td>
</tr>
<tr>
<td>Single gap</td>
<td>56</td>
</tr>
<tr>
<td>fill</td>
<td>56</td>
</tr>
<tr>
<td>Single point deletion</td>
<td>57</td>
</tr>
<tr>
<td>Static Trial</td>
<td>10</td>
</tr>
</tbody>
</table>
INDEX

T
Time Bar 21
Trajectory
  defragment 49
  ghost 46
  label manually 51
  overlapping 52
  unlabelled 30
  viewing 49
Trial
  replay 21
  run pipeline on 43
Trial Type
  dialog 34
    for dynamic trial 06
    for static trial 06
Trouble shooting reconstruction problems 25

U
Unlabelled Trajectories
  finding 31
Unlabelling
  trajectories 27

V
View
  menu 24
  multiple labelled trajectories 49
  part of a trial 23
  trajectories 47